
NEW! QX-TOOLS 2.0 — 15 XTENSIONS FOR THE PRICE OF ONE!

Create type effects in QuarkXPress,
rather than jumping back and forth to
Photoshop. Visually and interactively
create drop shadows, glows, bevels and
embosses from type, pictures, boxes or
lines. Effects can be created, then saved
in a popup menu that quickly allows
applying to objects with one click.

• Effects can be created in a visual,
interactive editor.

• Control DPI and use of CMYK, RGB
Grayscale TIFF or one-bit dither.

• Control direction of light, brightness,
stroke width, blur, opacity, highlight
and shadow color.

• Create Shadows, Glows, Bevels and
Embosses.

QX-PRINT

Several new options to the Print dialog
box enable you to save a region of your
page as an EPS file, print spot colors
as process colors and much more!

• Save a selected region or items as an
EPS file.

• Print spot colors as process colors.
• Move from the Print dialog to the

Page Setup dialog with a mouse click.
• Print non-contiguous pages and 

multiple plates.

QX-FIND/CHANGE

Document-wide changes that would
normally involve tedious and time-
consuming individual editing can now
be made in seconds. Search and replace
on lines, boxes, colors and other object
attributes, instead of just text.

• Search and replace on lines, rules,
style sheets, frames, colors, character
attributes, paragraph attributes, text
boxes, and picture boxes.

• Includes buttons for Find, Change,
Find then Change, and Change All.

• Character and paragraph attributes 
can be searched in current text 
stream or entire document.

Apply Photoshop plug-ins to images
without leaving QuarkXPress. Masking
capabilities allow combining graphic
effects with type.

• Filter operations can be undone.
Does not affect the original image.

• Can be used with other Photoshop 
plug-in filters, including Extensis 
Intellihance.™

• Includes a dozen built-in filters.
• Masking features offer several 

options for applying filters to images 
masked by QuarkXPress objects.

Offers a precise layer manager for
working with multiple stacked objects.
An indispensable XTension that makes
working in multiple layers an effortless
experience.

• Assign objects to layers—just like the
Layers palette in Adobe Illustrator®

and Photoshop®.
• Name, move, group and order layers.
• Hide layers for printing multiple 

variations or to work easier and 
faster in specific areas.

• Eliminate accidental moving or 
resizing with locking layers.

Create and save custom New Document
settings which can be accessed via a
pop-up menu. Avoid searching for lost
templates by adding custom paper sizes
of frequently used publication sizes,
including page counts.

• Popup allows switching between 
Portrait and Landscape.

• Name documents at creation, instead
of waiting until they are saved.

• Define page counts and section 
starts.

Lets you easily turn XTensions on or
off when launching QuarkXPress—sav-
ing valuable memory and eliminating
XTension conflicts.

• Create and store XTension sets for 
specific jobs and clients.

• Quickly change the amount of RAM 
allocated to QuarkXPress.

QX-MANAGER

QX-VIEWER

Displays a miniature representation of
any page or spread so you can quickly
navigate your document.

• A resizable floating preview that 
displays page spreads.

• Offers magnification levels up to 
900%—more than double the zoom 
level of QuarkXPress.

• Zoom in and scroll the document 
window by clicking and dragging in 
the window.

QX-SMART BAR

Provides power single-click access to
hundreds of QuarkXPress commands.
These customizable toolbars can be
embedded on the top, bottom, left and
right sides of the screen, or be dis-
played as floating palettes.

• QX-SmartBars is an intelligent agent
that builds toolbars for you.

• Create custom buttons for opening
files, launching XTensions, or select-
ing menu commands.

QX-DINGBATS
QX-LAYERS

QX-SCALER

Lets you scale the height and width of
multiple objects such as text, graphics,
and lines simultaneously by any per-
centage or a specific unit of measure-
ment. Plus, QX-Scaler supports Undo,
so if you’re unhappy with the results of
the scale, you can undo it.

• Scale multiple objects simultaneously
such as text, graphics, and lines.

• Elements can be scaled in proportional
or non-proportional percentages,
dimensions, or combinations of both.

• Interactive scaling allows you to 
scale a group of objects by hand.

• Create custom scale sets or use the 
QuickScale toolbar buttons for com-
monly used scaling percentages.

• An “Undo” function allows you to 
quickly  undo any previous scaling 
operation.

• Individually control the scaling of 
text, graphics, and lines.

Create character-based style sheets for
selected text without modifying the
entire paragraph. The QX-Styles
palette displays both character styles
and paragraph styles allowing you 
to access both types of styles in one 
convenient palette.

• Create styles for selected text, with
out affecting the entire paragraph.

• Work with both paragraph and 
character styles from single palette.

• Create sets of commons used styles.
• Quickly modify character attributes 

using QuickStyle buttons.

QX-STYLES

QX-TIPS & TRICKS

View and search through hundreds of
QuarkXPress Tips and Tricks from
best-selling author, David Blatner. Tips
can be shown at startup and shut-
down, and can be searched by keyword.
Helps you get “unstuck” when you have
a problem with QuarkXPress.

Requirements:
QuarkXPress 3.31 or later and System 7.1 or later.
Guaranteed compatible with QuarkXPress 4.0.

QX-FILTERS

Extensis, the Extensis logo, QX-Tools, QX-SmartBar, QX-CopyStyle, QX-
DocStyles, QX-Effects, QX-Find/Change, QX-FineTune, QX-Print, QX-Tips &
Tricks, QX-Scaler, QX-Styles, QX-Layers, QX-Dingbats, QX-Manager, QX-
Viewer and QX-Filters are trademarks of Extensis Corporation. Intellihance is a
trademark of DPA Software. QuarkXPress is a registered trademark and
XTensions is a trademark of Quark, Inc.All other trademarks are the 
property of their respective owners.
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QX-COPYSTYLEQX-EFFECTS QX-FINETUNE

Makes it easy to locate and insert
unusual characters and symbols into
text with a single mouse click.

• A floating, resizable palette that 
displays graphic representations 
of fonts.

• Includes five free Monotype™

PostScript™ Dingbat-style fonts.

Ensures design consistency across a
document, making attention to detail
faster and easier than ever before.

• Copy and paste entire sets of attrib-
utes for paragraphs, pictures, text,
frames, structure, box color and 
trapping from one box to another.

• Undo and redo changes.

Quickly and interactively format para-
graphs, boxes, text, and paragraph
rules. Controls normally hidden in
dialogs are brought to the surface, and
changes are displayed immediately
and constantly.

• Spinner controls allow quick adjust-
ment of boxes, characters, paragraph 
rules and indents.

• Editable numeric readouts quickly 
show precise values. Key in exact 
values if desired.

•  Avoid searching for values hidden 
in dialogs.

Extensis Corporation
55 S.W. Yamhill Street, Fourth Floor   Portland, OR  97204
1-800-796-9798  Phone (503) 274-2020  Fax (503) 274-0530

Internet: info@extensis.com   AOL: Extensis   Compuserve: 70242,33
http://www.extensis.com

QX-DOCSTYLES
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QX-Tools

Introduction
Welcome to Extensis QX-Tools. You’ve just purchased a collection of
XTensions™ that enable you to work faster, easier and more efficiently
in QuarkXPress®. QX-Tools was designed to address the everyday
needs of QuarkXPress users.

The 15 XTensions in QX-Tools share a consistent user interface and
are designed and tested to work smoothly with QuarkXPress 3.32. 
We believe you’ll find QX-Tools a natural extension of QuarkXPress. 
QX-Tools and QuarkXPress—standard equipment for creative 
professionals. 

System and Software Requirements
To use QX-Tools, you need the following software:
• Apple® Macintosh® System 7.1.1 or later 
• QuarkXPress 3.32 or later

Installation
Before installing, turn off any anti-virus software and extensions,
except for your CD-ROM extensions. Then restart your computer. 

1. Insert the disk that came with your product.
If you received a CD-ROM version, you will notice that other
Extensis products are available for you to install. These products
are full working versions of Extensis products that you can run in
Demo mode.

2. Double-click the installer icon.
The Introduction dialog box appears.

3. Click the Continue button.
The Welcome dialog box appears. Release notes and special
instructions are displayed in this window. It is important that you
read these release notes since they contain information not
included in the manual. You should save or print these release
notes before continuing the installation.

4. Click the Continue button.
The Installation dialog box appears. 

5. Click the Install button.
The Disk Selection dialog box appears. The dialog box requests
that you select the disk on which you want the Extensis product
installed.

6. Select a disk.
Once a disk has been selected, you will need to locate the
application for which you want to install the Extensis product.

7. Click the Select button.
Once installation is complete, the successful installation dialog
appears. The installer will prompt you to restart your computer if
necessary.
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Tip

We can also be reached via fax
at (503) 274-0530, or through
the online services listed below.

CompuServe: 70242,33
America Online: EXTENSIS
E-Mail: support@extensis.com
Web: http://www.extensis.com

Registration
It is important to register your copy of QX-Tools so we can provide
you with service. Registered users of QX-Tools are eligible for
technical support, information regarding new versions, products and 
discounts and special offers on new products.

QX-Tools includes electronic registration, so registering has never
been easier! The first time QuarkXPress is launched, after QX-Tools is
installed, the QX-Tools Personalize dialog box appears. To personalize
QX-Tools, type your name, company and QX-Tools registration
number. Your product registration number is located on your QX-
Tools manual. If you choose not to personalize your copy, QX-Tools
will run in a 30-day demonstration mode. 

Once you have personalized QX-Tools, a dialog box appears asking if
you would like to register. To register QX-Tools, click the Register
QX-Tools button and an electronic registration screen appears. After
you’ve completed the registration screen, a Market Research screen
and a System Configuration screen will follow. The Market Research
screen asks basic questions which enable us to better understand your
needs. The System Configuration screen provides a “snapshot” of your
system configuration which enables Extensis to support you more
effectively. Sending the Market Research and System Configuration
information is optional, if you don’t want to send this information to
Extensis, you may check the checkbox at the bottom of these screens. 

If you have a modem connected to your computer, you can register
toll-free by modem. If you do not have a modem, you can print the
registration sheet and register either by faxing it to (503) 274-0530 or
drop it in the mail in the postage-paid envelope provided. If you don’t
have access to a modem or printer, you can still register by filling out
a registration sheet located at the end of this manual. 

Technical Support
For questions regarding QX-Tools, please first refer to this manual,
which describes the features and basic operations. If you have a 
question or problem that is not addressed in the Troubleshooting
section or the manual, technical support is available at (503) 274-7030,
Monday through Friday, between the hours of 8:00 a.m to 5:00 p.m.
Pacific time. 

When calling technical support, please be at your Macintosh® and have
the following information available: your QX-Tools registration
number, your Macintosh configuration and your question or a
description of the difficulty you’re experiencing—what specifically
occurs and when. Take note of any displayed error numbers or
messages and any other information you think may be relevant.
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Suggestions
We’d love to hear your comments about QX-Tools, ideas for new
XTensions, or improvements on existing XTensions. A suggestion
sheet is included at the end of this manual. Please fax or mail your
comments and suggestions to Extensis.

QX-Tools Keyboard Shortcuts
The QX-Tools XTensions can be quickly accessed by a keyboard
shortcut. Each XTension has its own default hot key and you can 
modify hot keys to your preference. To modify the QX-Tools hot 
keys, choose QX-Tools Prefs from the Preferences submenu of the
Edit menu.

3
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QX-Bars

QX-Bars brings the one-click convenience of toolbars to
QuarkXPress, offering instant access to hundreds of QuarkXPress
commands, tools and menus. Several preconfigured toolbars are
provided that include tools and commands that any QuarkXPress user
will find immediately useful. 

But since not all users are the same, QX-Bars gives you the power to
customize toolbars by adding, removing or arranging buttons to your
preference. Also, toolbars can be displayed or hidden as needed. For
example, you can create a toolbar specifically for formatting text but
keep it hidden until needed.  

QX-Bars even allows you to create custom buttons for accessing
QuarkXPress menus, files, folders and other applications through the
toolbar. For example, the Font menu, QuarkXPress files and folders or
an application, such as Photoshop, can be launched through toolbar
buttons. QX-Bars gives you the power to work more efficiently by
putting the commands you use most, right at your fingertips.

SmartBars
SmartBar automates the task of creating buttons and toolbars by
watching and recording your menu selections. Just turn on the
SmartBar option and SmartBar begins watching you work. As you use
QuarkXPress menu commands, SmartBar creates a corresponding list
of buttons (up to 15). With a click of a button, you can convert these
SmartBar buttons into a toolbar. Then, instead of searching for a
command in a menu, just click a toolbar button.

To turn on or off SmartBar:

• Choose SmartBar in the View menu. 
SmartBar immediately begins watching you work and creates a
button for each menu command you select. (“Watch Me” only
functions when SmartBar is open and Watch Me is turned on.) You
can turn SmartBar on and off by clicking the “Watch Me” button
in SmartBar.

To see SmartBar options:

• Click the arrow above the SmartBar scroll bar. 
A pop-up menu appears, displaying a list of options. The first three
options correspond to the buttons along the top of the SmartBar
palette. The fourth option allows you to hide the toolbar at the top
of the SmartBar palette. The final option allows you to turn on and
off Hot Help.

The Watch Me button

QX-Bars button



Displaying or Hiding Toolbars

To display or hide toolbars:

1. Choose Toolbars from the View menu.
A pop-up list of toolbars appears. Checked toolbars are visible.

2. Select a toolbar from the list. 
Selecting an unchecked toolbar displays it, selecting a checked toolbar
hides it.

Resizing and Embedding Toolbars

To move a floating toolbar:

•  Click and drag the toolbar’s title bar or any gray area around the
buttons and move to the desired location.

To resize a floating toolbar:

1. Position the cursor over the resize box at the bottom right 
corner of the toolbar.

2. Click and drag the toolbar in any direction.
The cursor displays as a two-way arrow and an outline appears as the
toolbar is resized. As you drag, the outline indicates the toolbar’s new
size which snaps to fit the buttons. 

To embed a floating toolbar:

• Drag the floating toolbar to the top, bottom, left or right side of the
screen.
When you release the mouse button, the toolbar embeds into the side
of the screen.

To detach an embedded toolbar:

1. Position the pointer in the gray area surrounding the buttons.
2. Drag the toolbar away from the edge of the window.

The embedded toolbar becomes a floating palette with a title bar.
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Tip

Hot Help enables you to hold
the pointer over any toolbar
button to instantly view a
button’s name. This is useful
for discovering a button’s
function and is available for
all QX-Tools XTensions.

Tip

Double-clicking the title bar 
or gray area around toolbar
buttons embeds a floating
toolbar to the edge of the
screen. Double-clicking an
embedded toolbar detaches 
it to become a floating toolbar.



6

Fit box to picture Fit picture to box

The Edit Toolbars button

Tip

Three special feature buttons
are available in the QX-Tools
Category. The Fit box to
picture button instantly
resizes the picture box to fit
the picture. The Fit picture 
to box button resizes the 
picture to fit the picture box.
The Ungroup all button
ungroups nested sets of
grouped objects.

Ungroup all

Creating and Editing Toolbars

To automatically create buttons and toolbars using SmartBar:

• Click the “Build Bar” button to create a toolbar containing all
buttons listed. Or, select one or more buttons in the SmartBar
palette using the Shift key and click the “Build Bar” button. 
A QX-Bar containing the SmartBar buttons is automatically created for
you.

To clear the SmartBar button list:

1. Click the “Reset List” button. 
2. To empty the button list in SmartBar, click OK in the dialog box

that appears.

To create and edit toolbars:

1. Choose Edit Toolbars from the Edit menu or click the Edit Toolbar
button on a toolbar. 
The Edit QX-Bars dialog box appears. A list of available toolbars is
displayed. A checkmark to the left of the toolbar name indicates the
toolbar is visible. To hide a toolbar, click on the checkmark. The
toolbar and checkmark disappear.

To create a new toolbar, click the New button.
To duplicate a toolbar, click the Duplicate button.

A New Toolbar Name dialog box appears. Once the toolbar is named,
the new toolbar will include the same buttons as the original.

To rename a toolbar, click the Rename button.
To delete a toolbar, click the Delete button

The highlighted toolbar is deleted.
To customize a toolbar, click the Customize button.

The Build Bar button

The Reset List button
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Adding and Deleting Buttons
A toolbar needs to be visible before adding or deleting toolbar buttons.

To add buttons to a toolbar:

1.  Choose Edit Toolbars from the Edit menu.
The QX-Bars dialog box appears.

2.  Click the Customize button.
The Customize QX-Bars dialog box appears.

3.  Select a Category. 
Once a Category is selected, the buttons from that category appear 
in the Buttons field. If you hold your pointer over a button, the
Description field displays the button’s description.

4.  Click and drag a button to the toolbar.
Once the button is dragged onto the toolbar, the toolbar will update
to display that button on the toolbar. 

To delete buttons from a toolbar:

• Toolbar buttons can be deleted by holding down the Command
key while dragging a button off a toolbar or selecting a button
and pressing the Delete key while the Customize dialog box is
open. 

A The Categories field displays a list of available
categories. Each category contains its own set
of buttons. For example, the Style Category 
displays buttons that represent the commands
available from the QuarkXPress Style menu.

B The Buttons field displays buttons for the
currently selected Category. Holding your
pointer over a button displays a description of
the button in the Description field. Buttons can
be dragged from the Buttons field and added to
any new or existing toolbars.

C The Description field displays a description of
the currently selected button.

D The New button displays the Edit Custom
Button dialog box. You can create new buttons
to access keystroke commands, menu items
and Finder items.

D

B

A

C

The Customize QX-Bars dialog box

Tip

To instantly create a new 
toolbar, simply drag a button
to the desktop from the
Customize dialog box.

Tip

To delete buttons without
opening the Customize
dialog box, simply drag a
button off a toolbar while
holding down the Command
key.
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Moving and Adding Space Between Buttons
Moving and adding space between buttons enables you to customize
toolbars and group similar function buttons.

To move buttons on a toolbar:

1.  Open the Customize QX-Bars dialog box.
2.  Select the button you want to move and drag it to a new

location on the toolbar.
When the mouse button is released, the button appears in its new
location. You can also move buttons to other toolbars simply by
dragging the button to a toolbar while holding down the Command
key. 

To add space between buttons on a toolbar:

1.  Open the Customize QX-Bars dialog box.
2.  Drag a button slightly to the right on a horizontal toolbar or

down on a vertical toolbar.
The button appears inverted as it is selected and dragged. When
the mouse button is released, space is inserted before the selected
button. Dragging a button slightly to the right or left (horizontal)
or up or down (vertical) inserts or removes space accordingly.
Repeat this process to add double space between buttons.

Creating Your Own Buttons
You can create buttons for custom hot keys, XTensions, QuarkXPress
menus, files, or folders and other applications. For example you can
create a button to access the Font menu, a QuarkXPress file or folder,
or launch your favorite application through a QX-Bars toolbar button.

To create a New button:

1. Open the Customize QX-Bars dialog box.
2. Click the New button.

The Edit Custom Button dialog box appears. You can create 
buttons for Keystroke commands, Menu items and Finder items. 

Tip

To Move or modify a button’s
spacing without opening the
Customize QX-Bars dialog
box, hold down the Command
key while dragging a button.

Tip

To open the Customize dialog
box directly, use the
Customize button on the QX-
Tools toolbar.

The Customize button
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Tip

For best results, custom
designed icons should be 
19 x 17 pixels (width/height). 

To create a keystroke command button:

1. Select the keystroke text-entry field.
A dialog box appears for entering a keystroke.

2. Type the desired keystroke combination and click OK. 
Whenever you select the toolbar button the keystroke will be
activated.

To create menu buttons: 

1. Click the Menu radio button.
A pop-up menu appears to the right of the menu radio button. This
pop-up allows you to scroll through the menus to choose a menu
to attach to the custom button. 

2. Select a menu or menu item.
If you choose a pop-down menu, the button will display the entire
menu that was selected.

To create buttons for files or folders: 

1. Click the Finder Item radio button.
A dialog appears asking if you want to attach a file or folder to the
custom button. If you attach a folder, it will display the contents of
the folder as items in a pop-up menu.

2. Select a file or folder option.
A menu appears so you can find the appropriate file or folder on
your hard drive.

3. Select the file or folder you want to attach.
Once a file or folder is selected, it or its contents will be directly
accessible through this button. 

To select an icon for a custom button:

1.  Open the Customize dialog box.
2.  Click the Select Icon button.

The Define Icon dialog box appears. Select an icon from the 
several sample icons provided, design your own icons using any
Macintosh paint program or copy and paste images from other
documents. Once a custom designed icon is pasted from the
Clipboard, QX-Bars automatically adds an icon border. 

3. Select an icon and click the Delete button.
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QX-Styles

How many times have you wanted to apply different style sheets to
multiple items in the same paragraph? With QuarkXPress, it’s
impossible to apply multiple style sheets in the same paragraph since
QuarkXPress style sheets are paragraph-based. Therefore, any style
sheet you use is applied to the entire paragraph. Now, QX-Styles
offers character-based style sheets that allow you to change the
attributes of selected text, not the entire paragraph. QX-Styles is ideal
for formatting footnote numbers, run-in heads, drop cap styling and 
caption numbers.

Not only does QX-Styles let you create character-level style sheets 
but it also displays any QuarkXPress paragraph style sheets in the
QX-Styles palette. Now you can work from one palette instead of two.
The QX-Styles toolbar offers buttons to quickly create or modify
styles or apply “on the spot” style changes. QX-Styles stores
character-level style sheets globally so no matter what document
you’re working on, you have access to all of your QX-Style sheets.

A The Paragraph Style Sheet field displays the
available QuarkXPress paragraph-level style
sheets.

B The Character Style Sheet field displays the
QX-Styles character-level style sheets.

C The Set pop-up menu displays the available
sets of character-level style sheets. Multiple
style sheet configurations can be created,
stored and opened as needed.

D The QX-Styles toolbar enables you to quickly
modify character attributes such as font, size,
style, color, shade, tracking and baseline shift.
The Add Styles and Edit Styles buttons enable
you to quickly add or edit styles.

E The Command pop-up menu offers menu
access to the QX-Styles toolbar buttons. 
In addition, several options are available to
modify the size of the QX-Styles palette to 
your preference. 

E
C

B

A

The QX-Styles palette

D

The QX-Styles button
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Creating, Using and Editing Character Style Sheets

To create a character style sheet:

1. Choose Show QX-Styles from the View menu or click the 
QX-Styles button on a toolbar. 
The QX-Styles palette appears. The top half of the QX-Styles
palette lists the character style sheets. The document paragraph
sheets are shown at the bottom half of the palette.

2. Click the Add Styles button.
The New Character Style dialog appears. Select the character
attributes you want to apply for this style then click OK. Once the
new character style has been created, simply highlight text and
select the desired style from the QX-Styles palette to apply the
new style. 

To edit a character style sheet:

• Click the Edit Styles button. 
The Edit Character Style dialog box appears. From this dialog box
you can create, edit, duplicate or delete a character style sheet.
After changes are made to the style sheet, a dialog box will appear
to confirm that you want to apply the new style attributes to text
styled with the old style attributes.

Creating and Editing Style Sets
You can create several “sets” of character style sheets to be used for
particular jobs or clients. Style sheets can be loaded and unloaded by
switching sets.

To create or remove a set:

1. Choose Edit from the Set pop-up menu. 
The Edit Sets List dialog box appears. From this dialog box you
can create, edit, duplicate or delete sets.

2. Click the New button.
Once the new set is named, it will appear in the Set pop-up menu.

Tip

To create a new style based
on existing text, select the
text and click the Add Styles
button, the new character
style will have the style
options preselected to match
the selected text.

Tip

To directly edit a QX-Styles
or QuarkXPress style sheet,
hold down the Command key
and select the style in the
QX-Styles palette. 

The QX-Styles button

The Add Styles button

The Edit Styles button
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To add or remove character style sheets from a set:

1. Choose a set from the Set pop-up menu. 
2. Click the Edit Styles button on the QX-Styles toolbar.

The Edit Styles List dialog box appears. All character style sheets
are displayed. Click directly to the left of the style name to add or
remove a style from the set. A checkmark appears next to the style
name when it has been selected. 

Using the QX-Styles Toolbar
The QX-Styles toolbar offers quick access for applying “on the spot”
style changes. Choose from character attributes such as font, size, type
style, color, shade, tracking and baseline shift buttons. Several default
settings are available but you can also create your own settings to
customize the buttons to your preference.

To edit the character attributes toolbar buttons:

1. Select Edit from any QX-Styles toolbar button.
The Edit dialog box appears. From this dialog box you can add,
remove or edit colors and fonts. You can create, edit, delete or
duplicate any predefined setting. For instance, you can create a
14.5 pt. size option or add a 62% shade setting to the Shade
toolbar button. Any changes made to these buttons is stored in the
currently selected set. 

Tip

To reapply a style sheet to
text that has been modified,
simply highlight the altered
text, hold down the Option
key, and select the style
sheet from the QX-Styles
palette. The original style is
reapplied to the text.
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A The Layer field displays the layers in the
document. The listed layer order represents the
stacking order on the page. In this example, the
Standard layer is the top layer and the Cool
layer is the bottom layer.

B The Show/Hide column displays which layers
are visible or hidden. A checkmark in this column
indicates the layers that are currently displayed.

C The QX-Layers toolbar offers quick access
buttons for modifying layers.

D The Lock/Unlock column displays which layers
are locked or unlocked. A checkmark in this
column indicates which layers are currently
locked.

E The Set pop-up menu displays the available sets
of layers. Multiple layer configurations can be
created, stored and selected as needed.

F The Command pop-up menu offers menu
access to the same commands as the 
QX-Layers toolbar. In addition, several options
enable you to modify the size of the QX-Layers
palette.

G The Active Layer triangle indicates which layer
the currently selected object is on.

QX-Layers

When items such as picture boxes, text boxes or lines are created in a
QuarkXPress document page, each item assumes a position (or layer)
in a stacking order on the page. Stacking order refers to the position of
an item in relation to other items in front of or behind it. When items
are stacked on top of each other, it can become difficult to select, edit
and correctly restack the objects in the proper order. QX-Layers offers
precise layer control to easily manage and navigate layers.

With QX-Layers you can easily edit items while keeping them in
order. For example, you can assign a drop shadow to the bottom 
layer and a graphic to the top layer. Layers can be also be hidden. 
For example, for a project with multiple price points, you could 
produce one document and create a layer for each price point but
modify the visibility of layers. You can also lock layers so that they
cannot be inadvertently moved or resized. If the layer order is 
inadvertently modified with the Bring to front/Send to back 
command, layers can be instantly reordered with one click.  

QX-Layers lets you create sets of layers so you can switch between
groups of layers to have them instantly accessible when needed. You
can also choose to have QX-Layers show layers locally from spread to
spread, or globally by showing all layers in the document. For your
basic or complex projects, QX-Layers is a powerful XTension that
makes layer management easy.

The QX-Layers palette

E

D

C

B

A

F

G

The QX-Layers button
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Creating, Deleting and Modifying Layers

To create a new layer:

1. Choose QX-Layers from the View menu or click the QX-Layer
button on a toolbar.

2. Select the items that you want to place on a layer.
3. Click the New Layer button on the QX-Layers toolbar.

The New Layer dialog box appears. The Standard layer is a default
layer where items which haven’t been assigned a layer are stored.
This layer is always in the stacking order and cannot be deleted.

4. Enter a name for the new layer and click OK. 
The newly named layer appears in the palette list with an active
checkmark to the left of the layer name. 

To delete a layer:

1. Select the layer you want to delete in the QX-Layers palette list.
2. Click the Delete Layer toolbar button.

The layer name is deleted from the palette list and the items that
were assigned to that layer return to the Standard layer.

To modify the stacking order of layers: 

• Select and drag a layer to a new position in the layer list. 
The layer list represents the stacking order on the page. For
example the first layer is the top layer while the last layer is the
bottom layer. Once the mouse button is released, the selected layer
will occupy its new position in the layer list and the surrounding
layers will shift to accommodate the new layer. 

To select all items in a layer: 

1.  Select a layer from the palette list.
2.  Click the Select Boxes in Layer button. 

All items assigned to that layer are selected.

To merge layers: 

1. Select a layer from the palette list. 
The Active Layer triangle updates to indicate the layer selected.

2.  Move the triangle up or down to another layer in the column.
Items are reassigned and merged into the selected layer.

To add a selected item to a layer: 

1. Select an item on the page. 
2.  Select a layer from the palette list.
3.  Click the Add selected to Layer button.

The selected item is added to the layer.

Tip

To delete a layer and all
items assigned to the layer,
select the Delete Layer and
Boxes option from the
Command pop-up menu.

The QX-Layers button

The New Layer button

The Delete Layer button

The Add Layer button

The Select Boxes in
Layer button
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Creating Layer Sets

To create a set:

1. Choose Edit from the Set pop-up menu.
The Set dialog box appears. From this dialog box you can create,
edit, duplicate or delete sets.

2. Click the New button.
Once the new set is named, it is displayed in the Set pop-up menu.

Using Show/Hide and Lock/Unlock

To show/hide layers: 

Clicking next to the layer name under the “Eye” column toggles the
visibility of the items in that layer. If a checkmark appears, the items
are visible; if the checkmark is not there, the items are invisible.

To lock/unlock layers: 

Clicking next to the layer name under the “Lock” column toggles the
mobility of the items in that layer. If a checkmark appears, the items
are locked; if the checkmark is not there, the items are unlocked.

QX-Layers Preferences

To customize the QX-Layers preferences: 

• Click the Preferences button on the QX-Layers toolbar.
You can choose to show all layers for the entire document or to
display warning dialog boxes before deleting layers.

Three other options include:
Boxes on different layers can’t be grouped—If you select this
option, you cannot group objects in separate layers.
New items belong to selected layer—If you select this option,
new items will be placed on the current active layer and be in front
of the stacking order within that layer. If you do not select this
option, all objects default to the “Standard” layer and are placed at
the top of the stacking order for that layer.
Cycle In Layers—If you select this option, all objects moved to
the front or sent to the back will be moved within the current layer.
If you do not select this preference, objects will be able to move
between layers when Bring to Front or Send to Back is selected.

The Preferences button
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QX-Scaler

QX-Scaler quickly resizes any item or group of items such as text,
graphics and lines in one step. Items can be scaled in proportional or
non-proportional percentages, dimensions or combinations of both.
QX-Scaler is ideal for resizing an advertisement to fit a new
publication or changing a half page layout to a full page in seconds. 

QX-Scaler goes beyond basic scaling features in QuarkXPress by
allowing you to individually control the scaling of text, graphics and
lines. You can create sets of scaling options so you can store several
preconfigured scale settings. Interactive scaling allows you to scale 
by dragging the item handles until the item looks visually correct.

The QX-Scaler toolbar enables you to choose custom scale options or
select predefined scaling percentages from 25% to 200%. And most
importantly, QX-Scaler features an unprecedented Undo Scale button
so you can instantly undo unintended results. Once QX-Scaler has
saved you valuable time reducing or enlarging an existing layout, 
you will find QX-Scaler an indispensable tool for scaling items in
QuarkXPress.  

A The QX-Scaler Options field enables you to
individually control scaling for lines, text, graphics
and boxes. A checkmark next to the scaling
option indicates that it is active.

B The Proportional checkbox applies equal scaling
to the width and height of the selection.

C The Width and Height pop-up menu lets you
apply separate horizontal and vertical scaling.
Items can be scaled by a percentage of the item’s
current size or by entering new measurement
dimensions. 
To choose the exact height or width of a scaled
object, select the Proportional checkbox and
select Units in the pop-up menu.

D The Set pop-up menu displays the available sets
of scaling option configurations. Multiple groups
of scaling selections can be created, stored and
selected as needed.

E The QX-Scaler toolbar offers scale, interactive
scale and undo scale buttons and quick access to
several standard scaling percentages from 25%
to 200%.

F The Command pop-up menu offers menu access
to the same commands as the QX-Scaler toolbar.
In addition, the toolbar, sets menu and options
area can be hidden to make the QX-Scaler
palette smaller.

E

C

B

A

The QX-Scaler palette

F

D

The QX-Scaler button
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Scaling Items With QX-Scaler

To resize selected items:

1. Choose QX-Scaler from the View menu or click the QX-Scaler
button on a toolbar. 
The QX-Scaler palette appears. The height and width edit boxes
allow you to scale items vertically or horizontally by any
percentage or unit. The Proportional checkbox scales both the
height and width equally without typing the same amount twice. 

2. Select the item(s) to be scaled. 
3. Type the desired scaling in the edit boxes.

Any percentage lower or higher than 100% reduces or increases
the selected items respectively.

4. Click the Scale button on the toolbar or press the Enter key.
The selected items are resized according the specified percentages
or units. If you’re unhappy with the results of the scale, simply
click the undo button to undo the last scale.

Using Interactive Scaling
Interactive scaling enables you to resize by visually dragging items to
a new desired size.

To interactively scale items:

1. Select the item(s) to be scaled. 
If you want to scale multiple items, you need to Group the items
before scaling.

2. Click the Interactive Scale button on the QX-Scaler toolbar.
Drag the handles of the selected items to the desired dimension.

Undo Scale button

Interactive Scaling button

The QX-Scaler button
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Using the Individual Scaling Options

Scaling Options:

The QX-Scaler options enable you to individually control scaling for
lines, text, graphics and boxes. The following briefly describes the
custom scaling options available:

Text: Point Size—Scales the point size of text.
Text: Character Scale—Scales text horizontally while maintaining
relative proportions. 
Text: Paragraph Attributes—Scales paragraph attributes such as
leading, indents and spacing. 
Text: Text Chain—Scales all text linked to the selected text.
Text Box: Size—Scales the text box itself, not the contents of the text
box.
Text Box: Insets—Scales the text box insets.
Text Box: Gutters—Scales the text box gutters.
Text Box: Anchored Box—Scales anchored text boxes such as inline
graphics.
Text Box: 1st Baseline—Scales the first baseline, which is the first
line of text in each column of an active text box.
Text Box: Inter-Para Max—Scales the maximum amount of space
between paragraphs when you have justified alignment.
Picture Box: Size—Scales the picture box itself, not the contents of
the picture box.
Picture Box: Graphics—Scales the contents of picture boxes.
Runaround Outset—Scales the flow of the text around an object.
Frame Weight—Scales the line thickness of text and picture box
borders.
Line Weight—Scales the thickness of lines.
Line Length—Scales the length of lines.
Keep Relative Positions—Retains the position of objects in relation
to each other.
Scale From Centers—Object centers remain centered while scaling.
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QX-Tips & Tricks
QX-Tips & Tricks offers hundreds of valuable QuarkXPress tips
selected by David Blatner, author of QuarkXPress Tips & Tricks, to
help you use QuarkXPress more productively. If you click the “Show
tips at startup” checkbox, a new QuarkXPress tip is displayed each
time you start up or shut down QuarkXPress. 

Reading QX-Tips

To view tips at any time:

• Choose QX-Tips & Tricks from the Utilities menu.
You see the Tips & Tricks dialog box. Click the Next Tip button to
read the next tip.

To search for tips by topic:

1. Click the More Tips button in the Tips & Tricks dialog box. 
You see the More Tips dialog box. 

2. In the Find field, type the text you want to search for.
Both the title and body of the tip are searched.

3. Click Find to see the first tip matching your text.
Click Find All to reset the list and see all tips and tricks.

4. Select a tip title and click View to read it.

The QX-Tips button

A The Tip window displays QuarkXPress tips
in a scrolling field.

B The Next Tip button enables you to view
an additional tip. Clicking this button
displays the next tip in the series.

C The More Tips button displays a dialog box
that shows all available tips by their title.
You can quickly browse or find tips by
topic.

D The Show tips at startup checkbox
displays a new tip each time you open
QuarkXPress. Show tips at shutdown
displays a new tip each time you exit
QuarkXPress. 

E The Find field contains topic text for which
you want to search.

F The Find button displays all topics
matching your search criteria. The Find All
button resets the list to display all topics.

G The View button displays the selected tip
in the Tip window.

B

C

The QX-Tips & Tricks dialog boxes

E

G

F

D
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QX-Manager
XTensions such as QX-Tools are independent software modules that
add features or abilities to QuarkXPress. Since XTensions increase
QuarkXPress’ RAM requirements, it is advantageous to load only the
XTensions you need at any given time. Unfortunately, it is tedious to
enable and disable XTensions by dragging them in and out of the
QuarkXPress XTension folder. QX-Manager simplifies this process by
allowing you to choose which XTensions to load prior to launching
QuarkXPress. QX-Manager allows you to easily manage which
XTensions are loaded and to change the QuarkXPress memory
partition, therefore saving valuable memory space. 

Along with QX-Manager comes the QX-Manager Init, which allows
QX-Manager to move unused XTensions to a Disabled XTensions
folder. This fully disables demo XTensions that would cause
QuarkXPress to become a demo version. Also, QuarkXPress loads
faster because there are fewer XTensions to load. The QX-Manager
Init provides support for more than 50 XTensions and promotes better
memory usage.

With QX-Manager you can also create and store multiple sets of
preselected XTensions so they are available when needed. For
example, you can create a Daily set for the XTensions you use
everyday and a Table set for XTensions that simplify the process of
creating and editing tables and charts. Each set can be assigned its
own QuarkXPress memory partition size and a shortcut key for quick
access. There is also a “Run new XTensions” checkbox so any new
XTensions are loaded and included for all sets. You can also choose to
have QX-Manager appear before QuarkXPress is launched, so you can
choose which XTensions or sets you want to load depending upon
your workload for the day. QX-Manager is an essential tool for
managing all your QuarkXPress XTensions.

A The XTension list displays all the QuarkXPress
XTensions. A checkmark next to an XTension
indicates that it will be loaded the next time
QuarkXPress is launched.

B The XTension Set pop-up menu displays sets
of XTension selections. Multiple groups of
XTension configurations can be created,
stored and selected as needed.

C The Set Options fields let you change the
amount of RAM allocated to QuarkXPress and
assign a shortcut key for changing sets when
launching QuarkXPress without going through
the dialog box.  

D The General Options checkboxes offer options
for launching and incorporating new XTensions
into sets. In addition, you can choose to have
QX-Manager appear every time before starting
QuarkXPress so you can instantly change sets
or make adjustments to the loading XTensions.

C

B

A

The QX-Manager dialog box

D

The QX-Manager button
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Using QX-Manager

To enable or disable XTensions: 

You can bring up the QX-Manager dialog box while in QuarkXPress
or choose to have it appear prior to launching QuarkXPress. A
checkmark to the left of the XTension name indicates that the
XTension is enabled and will be loaded the next time you launch
QuarkXPress. 

No checkmark indicates that the XTension is disabled and will not be
loaded the next time QuarkXPress is launched. (Disabled XTensions
are stored in a folder called “Disabled XTension.” This folder is
located in the QuarkXPress folder at the same level as the XTension
folder. If you have a specific XTension in the “Disabled” folder and
attempt to install a duplicate of it, the “Disabled” XTension is moved
to the “Duplicate Items” folder and the new XTension takes its place
in the “Disabled” folder. This is also true if you try to copy an
extension into the XTension folder and an XTension by that name
already exists.) 

To toggle an XTension on or off, click on or to the left of the
XTension name. To quickly select/deselect a range of XTensions,
select and drag up or down the column. 

To force QX-Manager to open before launching: 

You can choose to have the QX-Manager open before QuarkXPress is
launched so you can load or unload XTensions or change sets.
• Select the “Always display upon launching” checkbox under

General Options. 

To create an XTension set: 

1. Choose Edit from the XTension Sets pop-up menu. 
An Edit XTension Sets dialog box appears. 

2. Click the New button. 
A Name New Set dialog box appears. 

3. Name the new set and click OK twice.  
Your new set will appear in the XTension Sets pop-up menu. You
can then select the XTensions you wish to load when the set is
selected.

To switch XTension sets: 

1. Choose a set from XTension Set pop-up menu. 
2. Close the QX-Manager dialog box by clicking OK.

The new set will be launched the next time you start QuarkXPress.
If you have assigned hot keys to a set you can simply hold down
the set’s hot keys when launching QuarkXPress to load that set of
XTensions.

The QX-Manager button

Tip

To modify XTensions before
launching QuarkXPress, hold
down the spacebar when the
QuarkXPress splash screen
appears to display the QX-
Manager dialog box.    
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QX-Viewer

The QX-Viewer palette displays a miniature representation of the
current page or spread. This floating resizable palette enables you to
efficiently navigate through the pages of a QuarkXPress document. 

QX-Viewer can be used to locate a page in your document or to
simply display two views of the same page simultaneously. Clicking
the displayed thumbnail places the corresponding section of the
document at the center of the screen. For instance, if you are working
on the top of page 8 at 400% and you want to view the graphic at the
bottom of page 9, simply click the graphic displayed in the palette and
the graphic on page 9 is placed in the center of the screen. Also, if you
click and drag in the QX-Viewer palette, it has the same effect as
using the QuarkXPress grabber hand. You can also change the
magnification of the page through the QX-Viewer palette. Choose
document magnifications from Thumbnails to 900%. QX-Viewer also
displays a red “you are here” triangle in the QX-Viewer palette so you
can see where you are on the current spread. 

The QX-Viewer toolbar buttons provide quick access for viewing the
first, last, next, previous page or to manually refresh the screen. You
can also customize the QX-Viewer dialog box to suit your needs. For
example, you can create your own magnification settings and hide or
display the QX-Viewer toolbar to modify the palette size to your
preference.

A The QX-Viewer window displays a miniature 
representation of the current page or spread. 

B The View pop-up menu enables you to change
the size of the document view. Choose from
viewing levels up to 900% or create your own.

C The QX-Viewer toolbar offers several options for
quickly moving through a document. The
“Preferences” button (on the right end of the
toolbar) enables you to control the settings that
affect QX-Viewer.

D The Page Number pop-up menu shows the page
number displayed in the QX-Viewer window. 
The pop-up menu lists all the page spreads in
the entire document so you can quickly move to
any spread.

E The Command pop-up menu offers menu access
to the same commands in the toolbar. In addition,
options for customizing the palette size are
available. 

F Click the bottom right edge to resize the window. 

C

B

A

The QX-Viewer palette

E

F

D

The QX-Viewer button
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Using QX-Viewer

To open the QX-Viewer palette:

• Choose Show QX-Viewer from the View menu or click the 
QX-Viewer button on a toolbar.
The QX-Viewer palette appears. A small preview of the current
spread is displayed in the palette window.

To resize the QX-Viewer palette: 

• Position your cursor at the bottom right side of the QX-Viewer
palette.
Click the bottom right side of the QX-Viewer palette and drag.
The cursor changes to a double arrow and an outline appears to
indicate the palette’s new size. When the mouse button is released,
the QX-Viewer palette is redrawn to the new size.

To change the view size of the document: 

• Choose the desired view size from the View pop-up menu.
You can choose views from Thumbnails to 900% or you can select
Edit to create your own view settings.

To view a specific spread in the document: 

• Choose the desired spread from the Page pop-up menu.
To move to the displayed spread simply click on the page in the
palette. A red navigational triangle indicates your location on the
page. You can also use the QX-Viewer toolbar buttons to move the
first, last, next, or previous page in a document. 

To customize the QX-Viewer Preferences: 

• Choose the Preferences button from the QX-Viewer toolbar.
You can choose instant QX-Viewer updates, preset automatic
updates or manual updates only. Minimize after resize adjusts the
new size of the palette to minimize any unused space. You can
choose to modify the palette to display in black and white or wire
frame. The color of the background, spine and edge can be
modified to any color. In the final option, select the checkbox so
the Option key will be required when jumping to another page.

Tip

Instantly move to a selected
page spread and access
master pages by holding
down the Command key 
and selecting the Page pop-
up menu. 

The QX-Viewer button

The Preferences button
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QX-Filters

QX-Filters allows you to apply Photoshop-compatible plug-in filters
to images within QuarkXPress. Filters can alter or distort images to
produce many interesting visual effects. Previously, filters could only
be applied in a photo-retouching package such as Adobe Photoshop™.
Now, QX-Filters offers an easy-to-use XTension which enables you to
run virtually any Photoshop compatible filter directly within
QuarkXPress.

You don’t even need to own a photo-retouching package to use 
QX-Filters, several built-in image filters such as Blur, Emboss and
Sharpen are included with QX-Filters. QX-Filters keeps a copy of
each new filtered image so you can undo filters or create several
different filter versions for each image. Once a filtered image has been
selected, you can delete unwanted filtered images with one click. 

The QX-Filters masking feature offers several options for applying 
filters to image areas masked by QuarkXPress objects. For example, 
if you have text on top of an image you can choose to apply a filter to
the entire image, just the portion of the image covered by text (mask),
or all of the image except the portion covered by text (invert mask).

A The Acquire pop-up menu displays Acquire Plug-
ins used for importing an image through a
scanner, video digitizer or other input device. 

B The Filter pop-up menu displays filters. Choose
from several Extensis filters or any Photoshop
compatible filters you have installed.

C The Current Filter field displays the name of the
filter used.

D The Current File field displays the file name of the
selected image.

E The QX-Filters toolbar enables you to move
between filtered images, delete unwanted images
and offers masking and preferences options.

F The Command pop-up menu offers menu access
to the same commands as the toolbar buttons. 
In addition, options for reducing the palette size
are available.

C

D

The QX-Filters palette

B
F

E

The QX-Filters button
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Using QX-Filters
Since QX-Filters applies complex filters directly within QuarkXPress,
it may be necessary to increase the QuarkXPress memory partition by
at least one megabyte. You can increase the memory partition of
QuarkXPress in the QX-Manager dialog box. The more memory
allocated to QuarkXPress, the faster QX-Filters can acquire or filter
images.

To open QX-Filters:

• Choose QX-Filters from the Utilities menu or click the 
QX-Filters button on a toolbar.
The QX-Filters palette appears. If this is the first time you are
opening QX-Filters, a dialog box appears asking you to locate your
Plug-in folder. The Extensis Filters are installed in the XTension
folder. Once you have located the folder, QX-Filters remembers
the location until the plug-ins are moved. 

Note: If any Photoshop-compatible filters are already installed on
your computer, you should move the Extensis Filters folder to the
same location as your other Plug-ins. For example, if you use
Photoshop, the Extensis Filters should be moved to the Photoshop
plug-ins folder. When all Plug-ins are located in one folder, QX-Filters
can quickly display all available filters.

To acquire images:

Acquire Plug-ins are used for importing images into your
QuarkXPress document. BlankTIFF, Extensis-TWAIN and Video
SnapShot are the three built-in acquire filters included with 
QX-Filters. If you have any other acquire filters installed, they can
also be accessed through the QX-Filters Acquire pop-up menu.
1. Select or create a picture box.
2. Choose the desired Acquire Plug-in from the Acquire pop-up

menu.
A dialog box appears, asking if over-writing the currently existing
image in the picture box is desired. If confirmed, QX-Filters
begins to execute the Acquire Plug-In selected. After dismissing
the dialog box, QX-Filters requests that you name and place the
TIFF image that will be created during the acquisition process. The
image will be subsequently placed in the QuarkXPress picture box.

The QX-Filters button
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Acquire Plug-ins:
BlankTIFF: This plug-in generates a blank TIFF. The size, format
and resolution of the blank TIFF can be specified in the BlankTIFF
dialog box. This plug-in is useful when you want to run an image
filter that creates its image from scratch, rather than manipulating an
existing image.
Extensis-TWAIN: This plug-in acquires images which have been
scanned from a TWAIN-compatible scanner.
VideoSnapShot: This plug-in captures an image from a standard
QuickTime Video digitizer. You can select the depth, freeze and frame.

Filtering and Masking Images

To filter images:

1. Select the image to be filtered.
QX-Filters can apply filters to gray scale, RGB or CMYK 
PICT or TIFF images. Refer to the QX-Filters File Type 
table for a more information on the types of files supported.

2. Choose an Image filter from the Filter pop-up menu.
After the filter has been applied to the image, a new file will be
created in the same folder as the original image file, appended with
a version number. For example, an image entitled Sunset would
become Sunset.1, Sunset.2 and so forth. You can step forward and
backward through these images using the toolbar. When you’re
satisfied with your final image, click the trash icon to delete the
other images. The trash can deletes all versions of the filtered
image except the image that is currently displayed. Refer to the
QX-Filters Compatibility table for a compatibility list of file types
and filters.

Warning: If you already have a file named Sunset.1 in the image
folder and you run a filter on an image entitled Sunset, QX-Filters will
overwrite the Sunset.1 file with the new filtered image. 

To mask an image:

The QX-Filters masking feature offers several options for filtering
images with QuarkXPress objects on top of images. 
1. Place the desired QuarkXPress object on top of the image.

Any QuarkXPress object such as text, line, rectangles and circles
can be placed on top of an image. 

2. Select the image.
3. Click either the Mask Selection or Invert Mask button.

The Mask Selection option applies the filter to the portion of the
image underneath the QuarkXPress object. The Invert Mask option
applies the filter to the whole image except the portion covered
with the QuarkXPress object.

Mask Selection Invert Mask

QX-Filters Compatibility

Gray Index RGB CMYK
8-bit Color 32-bit

PICT ✓ --- ✓ N/A

TIFF ✓ --- ✓ ✓

QX-Filters File Type

Filters RGB Gray CMYK

Gradient ✓

Saturation ✓

TintShift ✓

AutoContrast ✓ ✓

Blur ✓ ✓ ✓

Bright/Contrast ✓ ✓ ✓

Convolution ✓ ✓ ✓

Curves ✓ ✓ ✓

Despeckle ✓ ✓ ✓ 

Emboss ✓ ✓ ✓

Sharpen ✓ ✓ ✓
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Extensis Filters

AutoContrast: This filter searches for the white-point and black-point
of an image and stretches the tonal range between 0% to 100%.
Blur: This filter eliminates the noise in the parts of the image where
significant color transitions occur. This produces a softening effect
since the image transitions are smoothed by averaging the pixels next
to the hard edges of defined lines and shaded areas.
Brightness & Contrast: This filter allows you to edit the brightness
and contrast of an image.
Convolution: This editable convolution filter changes a pixel based
upon an equation relating to its neighboring pixels. You can
manipulate the image simply by entering numerical values in the nine
entry fields. In order for the picture to remain relatively cohesive, the
numbers should add up to 1, but an interesting effect could result if
they do not.  

Curves: This sophisticated tone curve filter is useful for working with
scanned images that often have very dark, shadowy areas that if
lightened via a brightness control, would wash out the whites and
lighter areas of the image. This filter enables you to adjust specific
areas of an image while leaving other ranges alone.

Despeckle: This convolution filter examines neighboring pixels to see
if the current pixel belongs. If the pixel is not within a tolerance value,
the pixel is averaged with its neighbors.
Emboss: This filter makes a selection appear raised or stamped by
suppressing the color within the selection and tracing its edges with
black.

The following sample Convolution matrices
offer some interesting visual effects.

Very blurry H line detect

V line detect Outline
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Gradient: This filter replaces an existing image with gradient colors.

Saturation: This is an effective filter for making select colors of a
dull image pop out.

Sharpen: This filter sharpens blurry images by increasing the contrast
of adjacent pixels. The filter finds areas in the image where significant
color changes occur and sharpens them.
TintShift: This filter takes the foreground color into account and
gradually tints all of the colors toward the foreground color.

QX-Filters Preferences
The QX-Filters Preferences dialog box enables you to select another
folder containing filters. The Preferences dialog box also offers
options for changing foreground and background colors since many
plug-ins incorporate the foreground and background colors in their
algorithms. 

Select either the HSL or RGB color model to
modify gradient colors. Colors can be edited
by selecting the checkboxes or changing the
direction of the gradient definition line in the
sphere. 

The gradient line represents the gradual 
transition of color from dark to light. To edit
the gradient line, click another area within 
the sphere. The displayed color gradient and
gradient line update to reflect the new color
direction.

Tip

If you have access to the
Web, you’ll find more tips on
using filters at
http://www.extensis.com. 

Tip

To improve images
automatically, use
Intellihance, another great
product from Extensis.
Intellihance improves the way
your digital images appear in
print or on the screen. It
intelligently analyzes each
image’s needs and then
automatically applies filters to
optimize contrast, brightness,
saturation, sharpness and
despeckle.

The Preferences button
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QX-Dingbats

For an easier way to find and enter special symbol characters, 
QX-Dingbats offers quick visual access to all those hidden and hard 
to find symbols. All symbols from the selected font are displayed 
in the QX-Dingbats dialog box. With QX-Dingbats, you can scroll 
to find the symbol, change the size and insert it into your text. 
QX-Dingbats also includes several Monotype symbol fonts such 
as Botanical, X-Mas, Parties, Sports and Transport.

A The QX-Dingbats window displays the special
characters available from the selected font. Use
the scroll bar to quickly view all characters or
resize the palette. 

B The Insert button inserts the selected special
character into the text or you may double-click 
the character.

C The Font pop-up menu enables you to quickly
change the font of the special character.

D The Size pop-up menu lets you specify the size of
the character you want to insert.

E The Command pop-up menu offers the Full Font
List so you can add or remove fonts to the 
QX-Dingbats Font pop-up menu.

A

The QX-Dingbats palette

E

D

B

C

The QX-Dingbats button
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Using QX-Dingbats

To open the QX-Dingbats dialog box:

• Choose QX-Dingbats from the Utilities menu or click the 
QX-Dingbats button on a toolbar.
The QX-Dingbats dialog box appears. The symbols for the
selected font are displayed in the QX-Dingbats window.

To insert a symbol:

1. Insert your cursor into a text box where you want the symbol
to be inserted.

2. Open the QX-Dingbats palette.
3. Select the desired symbol.

You can view several different font symbols and change the size
before inserting a symbol into the text.

4. Click the Insert button or double-click the symbol.

To add or remove fonts:

1. Open the QX-Dingbats palette.
2. Choose Show Full Font List from the Command pop-up menu.
3. Select the Fonts you wish to display.

Simply click to the left of a font name to select a font. A sample of
the selected font is displayed at the bottom of the palette.

The QX-Dingbats button
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QX-Print

QX-Print adds several new printing features to QuarkXPress including
the ability to print discontinuous pages and page ranges, print multiple
plates and print spot color as process colors all from within the
QuarkXPress Print dialog box. QX-Print also offers the ability to
switch between the Print and Page Setup dialog boxes via a user-
defined hot-key and save a graphically defined portion of a page as an
EPS file. 

The QX-Print features

A The Print Range field allows you to enter
discontinuous page numbers and page number
ranges in any order. 

B The Print Spot Colors as Process checkbox prints
any spot colors as process colors.

C The Print Multiple Plates feature allows you to
print multiple plates and select the plates you
want to print.

D The Switch Modifier feature offers a user-defined
hot key that can switch between the Print and
Page Setup dialog box while saving your settings. 

A

D

B

C

The QX-Print button
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Printing Discontinuous Pages

To print discontinuous pages:

QX-Print adds a discontinuous print range text-entry field to the
bottom of the Print dialog box. 
1. Choose Print from the File menu or click the Print button on a

toolbar.
2. Enter the desired page numbers or range of page numbers into

the text-entry field.
Enter combinations of page numbers and page number ranges in
any order. For instance, in the print selection displayed to the left,
QX-Print prints page ranges 1 through 3, page 7, pages 9 through
12, page 4, and from page 22 to the last page of the document.

If the minus (-) sign is included as part of the page number, use the
backslash (\) to signal QX-Print to treat the very next character as
part of a page number. For example, to print page numbers
App-5 through App-9 you would enter App\-5-App\-9 into the text-
entry field.

3. Click the Print button.
If an entered page number or range is invalid, QX-Print displays
an alert. The invalid page or page range is highlighted in the text-
entry field. Simply correct the page number or range, then click
the Print button again to continue printing. 

Note: Master pages cannot be printed with QX-Print. If a master page
is selected, the QX-Print options are grayed-out. 

Printing Multiple Plates

To print multiple plates:

1.  Choose On from the Separations pop-up menu. 
2. Hold down the Shift key while selecting the plate color from

the Plates pop-up menu. 
When more than one plate color is selected, Multiple Plates will be
displayed instead of the plate color name. To deselect a selected
plate color, hold down the Shift key and select the plate color
again. Only the selected plates will print when the Print button is
selected.

Note: Spot color plates are removed from the Plates pop-up menu
when the Print Spot Colors as Process checkbox is selected.

Tip

Holding down the shift key
and selecting All Plates will
toggle between selecting the
All Plates item and individually
selecting all the plate colors.

Tip

To enter page selections in
the QX-Print text-entry field,
use a comma (,) or slash (/)
to separate pages or page
ranges and use a minus (-)
between page ranges. To
print absolute page
numbers, use a plus (+)
before the page number.

The QX-Print button
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Printing Spot Colors as Process Colors

To Print Spot Colors as Process colors:

QX-Print adds a Print Spot Colors as Process checkbox to the bottom of
the Print dialog. 
1. Select the Print Spot Color as Process checkbox. 

All the spot plate names are removed from the Plates pop-up menu. 
2. Click the Print button.

Just before printing, all the spot colors in the document are temporarily
converted to process colors and, after printing is finished, the colors are
converted back to spot colors.

Switching Between Dialog Boxes

To switch between the Print dialog and Page Setup dialog:

This QX-Print feature enables you to instantly switch between the Print
and the Page Setup dialog boxes without losing any current settings. 
• Hold down the Option key and click the Print button in the Print

dialog box. 
The Print dialog box closes and the Page Setup dialog box opens. The
print settings are saved including any pages or page ranges in the 
QX-Print text-entry field. 

Warning: Settings not normally saved between printing jobs—such as the
number of copies, OPI and the Plate to print—are not saved when you
transfer to the Page Setup dialog box. 

To switch from the Page Setup to the Print dialog box:

• Hold down the Option key and click the OK button.
This saves the page settings, closes the Page Setup dialog box and
opens the Print dialog box.

Tip

You can change the Switch
Modifier key(s) in the QX-Print
Preferences dialog box. The
Option key is assigned as the
default Switch-Modifier key.
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Saving a Region as an EPS File

To save a region as an EPS file:

With QX-Print you can select a portion of a page to be saved as an
EPS file by either selecting objects or drawing a rectangle around a
selection of objects. QX-Print can also save the area enclosed by the
bounding rectangle of a selected item or items (including grouped
items) as an EPS file. 
1. Click the Save as EPS button on a toolbar.

Once the button is activated, the cursor appears as a crosshair
pointer. 

2. Draw a rectangle around the area you want to save as an EPS
file. 
A marquee indicates the area selected to be saved. This marquee
can be resized and moved either with the mouse or in the
Measurements Palette. To delete the marquee, click in the
document outside of the marquee or delete the marquee by
pressing the Delete key.

3. Choose Save Selection as EPS from the File menu.
The Save as EPS dialog box appears. Specify the name, scaling,
type of EPS file, data format and OPI settings for the EPS file. 

To save a selected object:

1. Select an object to save as an EPS.
2. Choose Save Item Bounds as EPS from the File menu.

The Save as EPS dialog box appears. Specify the name, scaling,
type of EPS file, data format and OPI settings for the EPS file.

The Save as EPS button
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QX-FineTune

QX-FineTune allows you to quickly change the appearance of objects,
rules, paragraphs and characters. QX-FineTune provides a tab for each of
these attributes.

Without QX-FineTune if you want to add a floating rule to the bottom of a
paragraph, you select Rules in the Styles menu, select a rule below and try
to determine what the appropriate settings are (such as length, offset and
width). Then, you’d close the dialog box and see if the values were
correct. If not, you would need to repeat these steps until you see the
results you want.

With QX-FineTune, you simply use the Rule palette and adjust the
controls until you see the results you want. QX-FineTune makes fine
tuning direct and easy.

A Each of the four QX-FineTune palettes
function similarly. Rule is shown here as an
example. Modifying an attribute is as simple
as clicking the up or down arrow or entering
a value in a text field and pressing Return
or Enter.

B The left-most column displays a graphical
representation of a specific attribute.

C The up and down arrows allow you to
increase or decrease an attribute’s value by
clicking the arrow.

D The text fields provide an alternative
method for adjusting an attribute’s value.
Enter a specific value in the attribute’s text
field and press Return to apply a new value.

CB

QX-FineTune palette overview

D

A

Tip

To multiply the value in a field
by 10, hold down the Shift key
while clicking the up or down
arrow. For finer tuning, hold
down the Option key while
clicking the up or down arrow to
adjust the value by 1/10 units.

The QX-FineTune button
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Paragraph
The Paragraph panel provides multiple controls over leading and
indents all in one palette.

To use the Paragraph panel:

1. Use your mouse to highlight one or more paragraphs.
2. Choose Show QX-FineTune in the View menu. Then click the

Paragraph tab.
3. Determine the attribute you want to change and then click its

up or down arrow.
You can also type a value in a text field and press Return.

Paragraph Options:

Below are descriptions of each attribute in the panel.

First Line Indent—To make the first line indent, enter a positive
number. To make the first line of a paragraph extend beyond the
subsequent lines, enter a negative number in this text field.

Right Indent—Left indent plus the right indent must be less than the
width of the box. Enter a positive number in this field.

Left Indent—Left indent plus the right indent must be less than the
width of the box. Enter a positive number in this field.

Leading—The behavior of this XTension is identical to the leading
control in the QuarkXPress measurements palette. (Leading is the
space between lines of text.)

Space before a paragraph—Changes the preceding interparagraph
spacing (shown as “Space Before” in the QuarkXPress Format dialog
box).

Space after a paragraph—Changes the following interparagraph
spacing (shown as “Space After” in the QuarkXPress Format dialog
box).

Drop cap - line count—Controls the number of lines deep that a drop
cap spans. This value is never less than two and is disabled if the
value for Drop Cap-Character Count is zero.

Drop cap - character count—Controls the number of characters that
are enlarged in a drop cap set. If this value is zero or 1, then the Drop
Cap-Line count is disabled. 
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Character
The Character panel modifies character attributes, such as point size,
baseline shift, shading, kerning/tracking and horizontal/vertical scaling.

To use the Character panel:

1. Select a character or block of text.
2. Choose Show QX-FineTune in the View menu. Then click the

Character tab.
3. Determine the attribute you want to change and then click its up or

down arrow.
You can also type a value in a text field and press Return. (For
example, type 24 in the point size text field instead of repeatedly
clicking the point size up arrow.) To change the scaling of a character,
click the Vertical/Horizontal scaling pop-up menu.

Character Options:

Below are descriptions of each attribute in the panel.

Point size—Changes the character’s point size.

Baseline shift—Positions a character above or below the baseline. (The
baseline is the imaginary horizontal line on which the standard letters sit.)

Character shading—Changes grayness or shading from 0% to 100%.

Kerning/Tracking—Changes spacing between characters. If more than
one character is selected, tracking is changed. If only one character is
selected or there is an insertion point, kerning is changed. Behavior is
identical to the Kern/Track option in the QuarkXPress Measurements
palette.

Vertical/Horizontal scaling—Changes the scaling of a character. This
attribute functions as a pop-menu menu. Click the Vertical/Horizontal
button. You can only adjust one type of scaling at a time.

Vertical scaling increases the height of a character without
changing the width.

Horizontal scaling increases the width of a character without
changing the height.
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Object
The Object panel affects text and picture boxes. The attributes it affects
include frame thickness and shading, box skew, background shading, text
inset, gutter width and number of columns.

To use the Object panel:

1. Select a picture or text box.
2. Choose Show QX-FineTune in the View menu. Then click the Object

tab.
3. Determine the attribute you want to change and then click its up or

down arrow to adjust the picture or text box.
You can also type a value in a text field and press Return.

Object Options:

Below are descriptions of each attribute in the panel.

Frame thickness—Changes a box’s frame width. This attribute is only
active if a picture or text box is selected.

Frame shade—Changes a box’s frame shade. This attribute is only active
if a picture or text box is selected and the thickness of the frame is greater
than zero and the frame color is not white.

Box skew (slant)—Measured in degrees. This attribute is only active if a
picture or text box is selected.

Background shade—If the background color of a box is “white” or
“none” the background color spinner becomes inactive.

Text inset—This controls the distance between the edge of a text box and
the text within it. A value of zero places text tangent to the box. For
example, a value of 6 points will create a distance of 6 points between the
box edge and the bounding box of the character. This attribute is only
active if a text box is selected.

Gutter width—This controls the space between columns. This attribute is
only active if a text box is selected and the text box contains more than
one column. 

Number of columns—This controls the number of columns in a text box.
This attribute is only active if a text box is selected. 
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Rule
The Rule panel controls paragraph rules. Rules can be above and below a
paragraph and have thickness, offset and indent properties.

To use the Rule palette:

1. Select a paragraph or add an insertion point and change the
thickness of the rule to greater than zero.

2. Choose Show QX-FineTune in the View menu. Then click the Rule
tab.
The related arrows are active in the palette.

3. Determine the rule attribute you want to change and then click its
up or down arrow.
You can also type a value in a text field and press Return.

Rule Options:

Below are descriptions of each attribute in the panel.

Offset of a rule above a paragraph—Controls the distance, in units,
between the top of a paragraph and the rule. This attribute is disabled until
the thickness of a rule is greater than zero.

Offset of a rule below a paragraph—Controls the distance, in units,
between the bottom of a paragraph and the rule. This attribute is disabled
until the thickness of a rule is greater than zero.

Thickness of a rule above a paragraph—Increases or decreases the
thickness (width) of a rule. Thickness is calculated in QXP Units, which is
set in the QuarkXPress General Preferences.

Thickness of a rule below a paragraph—Increases or decreases the
thickness (width) of a rule. Thickness is calculated in QXP Units, which is
set in the QuarkXPress General Preferences.

Left inset of a rule above a paragraph—Controls the offset from the
right margin. This attribute is disabled until the thickness of a rule is
greater than zero.

Right inset of a rule above a paragraph—Controls the offset from the
left margin. This attribute is disabled until the thickness of a rule is greater
than zero. 

Left inset of a rule below a paragraph—Controls the offset from the
right margin. This attribute is disabled until the thickness of a rule is
greater than zero.

Right inset of a rule below a paragraph—Controls the offset from the
left margin. This attribute is disabled until the thickness of a rule is greater
than zero.
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A The Copy button picks up the style of the object
or text block that you’ve selected. The Apply
button changes another object or text block to
match the copied style. Undo reverses the last
action.

B The Grow box expands and collapses the view. 

C The expanded view displays additional copy
options:

Picture Attributes appears if you select a graphic.
Scale (X and Y), offset (X and Y), angle, skew,
colorization, shade, negative, contrast, screens
and flip (horizontal and vertical) are copied.

Paragraph Attributes appears if you position the
cursor within a paragraph. Indents, space before
and after, leading, lock to baseline, drop caps,
keep with next paragraph, keep lines together,
alignment, H&J (hyphenation and justification)
and any applied style sheets are copied.

Text Style Attributes appears if you select
multiple characters. Font, size, style, color,
shade, scale, kern and baseline shift are
copied.  You can only copy text styles that do
not conflict with each other.

Frame Attributes changes width, color, shade
and style.

Structure Attributes changes angle, skew,
corner radius, columns, gutter width, text inset,
baseline, alignment and background color
(shade, color and blend).

Trapping Attributes changes background and
text behavior.

Box Color Attributes changes box color (shade,
color and blend).

B

The QX-CopyStyle dialog box

QX-CopyStyle

QX-CopyStyle picks up attributes from objects and text and applies them
to other objects (even groups of objects) and text. It even works between
documents. QX-CopyStyle has the unique ability to capture and apply
attributes such as box skew (slant), color and trapping. 

For example, imagine your QuarkXPress document contains a box with a
0.5 point red frame, a 10 degree skew and the text within the box is 12
point Times. You can capture and apply all of these attributes with just two
mouse clicks. Use QX-CopyStyle to quickly pick up and apply these
styles. On an object by object basis, you can even undo QX-CopyStyle
Applies.

C

The QX-CopyStyle button



41

Using QX-CopyStyle

To use QX-CopyStyle:

1. Open the QX-CopyStyle palette.
Click its button in the QX-Bars palette or choose Show QX-CopyStyle
in the View menu.

2. Click the grow box in the upper right corner.
You see an expanded QX-CopyStyle palette.

3. Select the attributes of the selected object that you want to copy.
The first option changes, depending upon what is currently selected.

Note: Conflicting text styles cannot be copied.  For example, if you
attempt to copy bold and plain text, a dialog box appears, indicating
that some attributes conflict with each other.

4. Select the text or object you want to copy and click the Copy button.
5. Select the text or object you want to attach the attributes to and

click the Apply button.

To undo an action:

1. Select the object(s) you want to revert to its original state.
2. Click the Undo button on the QX-CopyStyle palette.

The Undo option does not apply to text style changes.  Also, if you have
the Item tool selected in the QuarkXPress tool palette when you undo an
action, the reversal only effects the last box level attribute change. If you
have the Contents tool selected in the QuarkXPress tool palette when you
undo an action, the reversal only effects the last paragraph level attribute
change.  

Tip

The Undo option still works,
even after you’ve saved a 
document.

Item tool

Contents tool

The grow box

The Copy button

The Apply button

The Undo button
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QX-FindChange

QX-FindChange extends search and replace to include nearly every type
of object in QuarkXPress, including Text Boxes, Picture Boxes, Rules,
Style Sheets, Colors, Character, Paragraph, Lines and Frames.

QX-FindChange operates as a tabbed dialog box. Clicking a tab displays a
panel of tools for a specific design element. (Refer to the QuarkXPress
documentation for descriptions of these QuarkXPress design elements.)
Experimenting with new attributes has never been easier. Just select the
options in a QX-FindChange panel and apply them to your document. 

On the next few pages, you’ll see each panel and learn the usefulness of
each. As you read about these powerful, flexible features, try them on your
own.

To use any QX-FindChange attribute:

1. Choose QX-FindChange in the Utilities menu.
The QX-FindChange dialog box appears.

2. Click the tab corresponding to the attribute you want to change.
3. Select the options and provide the information for the changes.
4. Click the Find First button to locate the first occurrence matching

your search criteria.
Found objects appear selected in the upper left corner of the document
window.

5. Click the “Change,” “Change, Then Find” or “Change All” button.
6. Click the Close box in the upper, left corner to exit the 

QX-FindChange dialog box.

A In the Text Boxes panel, you can search for
numbers of columns, gutter width and
characteristics associated with text boxes.
Search for box angle, skew, text inset and box
color and shade.

B The Find This area contains the options for
which to search.

C The Change To This area indicates how you
want to change the occurrences that match
your search criteria.

D Some panels include a feature for applying the
change to the current text chain or to the entire
document. 

Find First locates the first occurrence of your
search criteria.

The Change button changes the current
occurrence without looking for the next.

The Change, Then Find button changes the
selected occurrence and immediately searches
for the next.

The Change All button changes all
occurrences of the search criteria.

E The Close box exits the QX-FindChange dialog
box.

The Text Boxes panel and descriptions of common options

CB

D

The QX-FindChange button

E
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The Picture Boxes Panel
In the Picture Boxes panel, you can search for many of the attributes you
set in the QuarkXPress Picture Box Specifications dialog box. Select
Modify in the QuarkXPress Item menu to see this dialog box. For
example, you can search for and change attributes specific to the picture
within the box, or you can search for attributes specific to the box.

The Rules Panel
In the Rules panel, you can search for paragraph rules (as opposed to line
objects). 
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The Style Sheets Panel
In the Style Sheets panel, you can search for text that has been tagged with
a specific style and replace it with another style.

The Colors Panel
In the Colors panel, you can search for and replace color and shade
applied to an object. Color can be applied to text boxes, picture boxes,
lines and text.
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The Character Panel
In the Character panel, you can search for text by its font, size, color,
shade, baseline shift, tracking and scaling.

The Paragraph Panel
In the Paragraph panel, you can search for a paragraph by multiple
attributes, including its indents, leading, space before and after the
paragraph, drop caps and alignment.
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The Lines Panel
In the Lines panel, you can search for lines (not paragraph rules). Search
for and change the line’s style, end caps, color, shade and thickness.

The Frames Panel
In the Frames panel, you can search for frames surrounding a picture or a
text box by its styles, width, color and shade.



47

QX-DocStyles

QX-DocStyles helps you begin thinking about the printing process early.
QX-DocStyles asks you to determine many of the printing specifications
when you first create a document.  You can then save and reuse them.  

For example, as a designer you may have a specific set of printing
requirements for a 16 page, 8-1/2x11 newsletter and another set for a 150
page, 5x9 user’s guide.  It’s also a great idea to save Standard Advertising
Units (SAU) for the ads you create.  You can use these SAUs over and
over again, without having to recreate them each for each ad.

QX-DocStyles adds these options:
• Landscape or portrait orientation
• Multiple choices of document sizes
• Section start options for saving frequently used section numbering

schemes, such as an appendix or an introduction
• Ability to select among standard styles (US Letter, US Legal, A4, B5

and others) and new styles you’ve added
• The ability to predefine the number of pages in your document

The QX-DocStyles dialog box

A The Page Size settings allow you to select
either landscape or portrait orientation and set
page dimensions. The Page Size is a part (or
subset) of the DocStyle.

B The Document Guides settings allows you to
define the margin settings, the number of
columns per page and the gutter (space
between pages).

C The Set Section Start settings checkbox
controls whether the values in the Prefix and
Start At fields are used.  The Format pop-up
menu contains number formatting options.

D This area contains the option of selecting
among several predefined document styles or
any new style you’ve created, the name that
will appear in the Title bar and the estimated
number of pages that your document will be.
Also, you can choose whether the new
document contains a text box within the page
margins and organize your pages so they
appear side by side.

E The Save Style button displays a dialog box,
allowing you to save the current settings for
later use.

F The Rename button displays a dialog box,
allowing you to rename the current document
style.

G The Duplicate button displays a dialog box,
allowing you to save the current settings under
a different name. This saves time by allowing
you to use existing settings for a slightly
different set of styles.

H The Delete button removes the selected
document style.

I The Update button changes the selected
DocStyle to match the current settings in the
QX-DocStyles dialog box. 
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Using QX-DocStyles

To create a new document style:

1. Open QuarkXPress. Choose New in the File menu and then choose
Document.
The QX-DocStyles dialog box appears, replacing the standard
QuarkXPress New Document dialog box. 

2. Enter the desired settings for this style.
3. Type a name for the new document window in the Document Name

field.
4. Click the New button.

The Save Settings As DocStyle dialog box appears.
5. Type a name for this document style.

Give the style a descriptive name.
6. Click the OK button.

The new style’s name appears in the DocStyles pop-up menu.
7. Click the OK button.

To rename an existing document style:

1. Choose the name of the document style you want to change in the
DocStyles pop-up menu.

2. Click the Rename button.
The “Rename Selected DocStyle to” dialog box appears with the
current name highlighted.

3. Type a new name.
4. Click the OK button.

To duplicate a document style:

If you have an existing document style that is similar to a new one you
want to create, you can save time by duplicating the existing style.  Then,
just change the make the minor changes, name it and save it. 
1. Choose the existing document in the Document Name pop-up menu.
2. Click the Duplicate button.

The Enter New DocStyle Name dialog box appears.
3. Enter a new name for the document style.
4. Click the OK button.

To delete a document style:

1. Choose the name of the style you want to delete in the DocStyles
pop-up menu.

2. Click the Delete button.
3. Click the OK button in the confirmation dialog box.

To update a document style:

If you want to change a DocStyle, use the Update button.
1. Choose the DocStyle to update from the pop-up menu.
2. Make the desired changes in the QX-DocStyles dialog box.
3. Click the Update button.
4. Click OK in the dialog box that appears to confirm the update.
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The QX-Effects button

The QX-Effects dialog box

QX-Effects
QX-Effects provides a suite of type effects. Access Bevel, Emboss, Glow
and Shadow effects, all from one palette. Each effect has its own dialog
box.

A The Apply Current Effect button applies the
currently selected filter setting to the selected
item in the document.

B The Create Effect button displays the dialog box
for the currently selected effect.

C Defines what part of the image the effect
considers the edge. Auto Image applies the
effect to the inside of the box around the image.
Item applies the effect to the edge of the box
containing the image.

D The TIFF Resolution pop-up menu allows you
to set the resolution of the resulting TIFF image.

E The TIFF Info pop-up menu allows you to see
information about the selected TIFF image.

F The Image File Type pop-up menu indicates
whether the resulting TIFF image will be in
RGB, CMYK, 8-bit grayscale or 1-bit dither
format.

G The Preferences button displays the
preferences dialog box.

H The QX-Effects tabs establish which effect you’ll
apply to a selected item in the document.

I The pop-up menu contains sets of effects
you’ve previously saved. Selecting one of these
saved sets and clicking the Apply (Checkmark)
button, immediately applies the effect to the
selected item. The last item in the pop-down
menu allows you to edit the effect.

J The Information area displays the current filter
settings without requiring you to open the
effect’s dialog box.

K This pop-up menu provides access to many of
the same options found in the QX-Effects dialog
box, in addition to other options.

KH
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The Create Effect button

The Apply Current Effect button

Tip

QX-Bars provides a quick,
convenient way to access
previously saved effects. Click
the Saved Effects button in the
QuickAccess toolbar to see a
list of all saved effect sets.
Choosing a set in this list
immediately applies the effect to
the selected image.

Using QX-Effects 

To create an effect using QX-Effects:

1. Choose an image or object in QuarkXPress to which you want to
add an effect.

2. Choose QX-Effects from the Utilities menu.
The QX-Effects palette appears. Use the pop-up menus in the palette to
establish settings for this effect:
“Select edge from”—Defines what part of the image the effect
considers the edge. Auto Image applies the effect to the inside of the
box around the image. Item applies the effect to the edge of the box
containing the image.
“TIFF Resolution (DPI)”—Determines the DPI of the image created
by the effects. In this pop-up menu, choose Edit to add or remove DPI
values. You can also input values from 32-4800 dpi, but under 300 is
recommended.
“TIFF Info”—If you select this button while a TIFF file is selected,
you will see the information about the TIFF, such as its file name,
location, type, mode, width, height, resolution and file size
“Image File Type”—Determines whether your image will be created
as an RGB, CMYK or grayscale.

3. Click the tab for the effect you want to create.
4. Click the Create Effect button.

A dialog box appears, allowing you to save the selection as a TIFF
(tagged image format) graphic file.

5. Enter a name and select a location for the graphic file and click the
Save button.

6. Use the options in the effect’s dialog box to create the desired effect
(explained later in this chapter). 

7. Click the Apply button to see the resulting effect.

To save QX-Effects settings for later use:

1. Once you’ve established the settings exactly as you want them,
click the Save button in the effect’s dialog box.
A Save dialog box appears, allowing you to name and save the current
effect’s settings.

2. Type a name for the settings. 
3. Click Save.

The name of the new settings appears in the QX-Effects palette in the
saved sets pop-up menu. It also appears in the pop-up menu toward the
bottom, left corner of the effect’s dialog box.
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To use QX-Effects settings that you’ve saved:

1. Choose an image or object in QuarkXPress to which you want to
add an effect.

2. Choose QX-Effects from the Utilities menu.
The QX-Effects palette appears.

3. Click the tab for the effect you want to use.
4. Choose the name of the saved effect in the pop-up menu.
5. Click the Apply Current Effect button.

To remove effect settings that you’ve saved:

1. Choose QX-Effects from the Utilities menu. 
The QX-Effects palette appears.

2. Click a the tab for the effect you want to delete.
3. Choose Edit in the pop-up menu.
4. Choose the name of the saved effect in the pop-up menu in the

bottom, left corner of the dialog box.
5. Click the Delete button.
6. Click Delete in the dialog box that appears, asking you to confirm

the deletion of the set.

The Apply Current Effect button
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Bevel
Bevels give an image a raised appearance by applying highlights and
shadows to its inside and outside edges. 

QX-Effects provides several tools for adding a bevel to an image. In
addition to choosing whether the bevel is applied to the inside or outside
edge of the selection area, you can select one of the four different bevel
shapes (Flat, Round, Slope and Double) and control the darkness of the
shadow. A Smoothness option is useful for softening the ridges of the
bevel and controls for the brightness and sharpness of the highlight are at
your fingertips. Selecting the direction of the light is as easy as entering a
value. As with all QuarkXPress effects tools, you can instantly preview a
bevel’s effect on an image, or preview it on demand by clicking the
Preview Now button.

A The Preview Area shows a sample of the Bevel
options before you apply them to your image.

B The Bevel Type pop-up menu contains an Inner
and Outer Bevel option.

C The Bevel Shape pop-up menu controls the
shape (either Flat, Round, Slope or Double) of
the bevel.

D Width determines the width of the bevel in an
image.
Softness softens the edge of the bevel.
Balance adjusts the balance between the
Highlight and the Shadow of the bevel. Further
left indicates more highlight color; further right
indicates more shadow color.

E Highlight Intensity and Shadow Intensity control
the strength of the bevel highlights and shadows.

F The Bevel Color pop-up palettes include an
assortment of colors. (These are the colors
you’ve already created in QuarkXPress.) These
palettes are disabled if you’re creating a a
grayscale image.

G The Light Direction field indicates and adjusts
the direction of the light source.

H The selected Auto Preview checkbox
immediately shows how the options you’ve
established effect the image. The Preview Now
button is only active when the Auto Preview
checkbox is not selected. When you click this
button, the Preview Area updates.

I The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved bevel sets appear in the
Bevel pop-up menu. Selecting a set displays its
settings in the dialog box. You can then apply
these bevel settings to the current image.

J Zooms in and out. 
K The Apply button adds your created effect to

the image and closes the Bevel dialog box.
L The grow box resizes the dialog box and

preview.
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Emboss
Emboss works like no other embossing tool. Its unique control and
emboss styles give you the ability to create cutouts, embosses, reliefs,
recesses and many other special effects.

Emboss includes options for selecting the emboss type, along with the
amount of embossing. You control the contrast, softness, highlight and
shadow of the embossing. In addition, you can add a directional light
source and customize the color of the emboss highlight and shadow.

A The Preview Area shows a sample of the
Emboss options before you apply them to your
image.

B The Emboss Type pop-up menu provides four
options:
Cutout pushes in the selection area.
Raise pushes out the selection area.
Edges applies the highlight and shadow
emboss colors around the inside and outside of
the selection edge. This effect more
dramatically defines the selection edge.
Blur creates an off focus, fuzzy emboss.
Invert changes the light direction 180 degrees.

C Amount indicates the width of the emboss.
D Contrast controls the amount of difference

between lightness and darkness in the image.
E Softness is a blur type setting to diffuse the

transition from light to dark.
F Highlight controls the strength of the emboss

highlights.
G Shadow controls the darkness of the emboss’

shadow edge.
H The Emboss Color pop-up palettes include an

assortment of colors. (These are the colors
you’ve already created in QuarkXPress.) These
palettes are disabled if you’re creating a a
grayscale image.

I The Direction field indicates and adjusts the
direction of the light source.

J Selecting the Auto Preview checkbox
immediately shows changes to your created
effect. The Preview Now button is only active
when the Auto Preview checkbox is not
selected. When you click this button, the
Preview Area updates.

K The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved emboss sets appear in the
Emboss pop-up menu. Selecting a saved effect
displays its settings in the dialog box. You can
then apply these emboss settings to the current
image.

L Zooms in and out. 
M The Apply button adds your created effect to the

image and closes the Emboss dialog box.
N The grow box resizes the dialog box and

preview.
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Glow
As an artist, imagine creating an image of a neon sign or a candle. You’d
typically add a glow effect around the outer edges of the neon sign and
around the candle’s flame. QX-Effects makes this process easy with its
Glow feature. 

Adding a glow is as easy as selecting the object and experimenting with
Glow’s tools. You can apply a glow to the entire image, or just to its
edges. You determine how far the glow should extend and determine its
radiance (or brightness). In the above candle example, you could apply a
low radiance for a soft glow, or a high radiance for an intense, bright glow. 

Also, the glow opacity (or darkness) is at your control. A good use of
opacity is on images containing light text applied to a light background.
Slightly increasing the opacity of the letters’ glow makes them more
visible against the light background.

A The Preview Area shows a sample of the Glow
options before you apply them to your image.

B The Glow Type pop-up menu provides two
options (mostly used for text purposes):

The Solid option fills in the holes in objects,
such as solid circles.

The Edges option does not fill in holes in
objects.

C Stroke Width controls the number of pixels from
the image that the glow extends. A higher
number indicates a further distance from the
image.

D Radiance indicates the brightness of the glow. 
A high number indicates more light intensity.

E Opacity indicates the percentage that entire
image is decreased in creating the glow effect.

F The Color pop-up pop-up palette includes an
assortment of colors. (These are the colors
you’ve already created in QuarkXPress.) The
color that you select determines the color of the
glow.

G The selected Auto Preview checkbox
immediately shows how the options you’ve
established effect the image. The Preview Now
button is only active when the Auto Preview
checkbox is not selected. When you click this
button, the Preview Area updates.

H The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved glow sets appear in the
Glow pop-up menu. Selecting a set displays its
settings in the dialog box. You can then apply
these glow settings to the current image.

I Zooms in and out. 

J The Apply button adds your created effect to
the image and closes the Glow dialog box.

K The grow box resizes the dialog box and
preview.

The Glow dialog box
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Shadow
Shadows give flat images a 3-dimensional, raised appearance. Use Effects
to customize a set of shadow preferences that you can apply to the current
selection. Then, you can save the set to use again later on another image.

Features of Shadow include the ability to use the selection area’s silhouette
or its outline to create a shadow. You have control over the distance that
the shadow will offset the image. (The shadow will be the same shape as
the selected image.) In addition, you have control over the amount of
shadow’s blur and opacity. As you adjust the Shadow settings, you can
preview the image in real time or on demand before you apply the shadow
to the image.

A The Preview Area shows a sample of the
options before you apply them to your image.

B The Shadow type pop-up menu provides two
options:

Outline applies the shadow effect to the area
defined by the outline of the selection.

Silhouette applies the shadow effect to all non-
white pixels in the selection.

C X Offset (pixels) establishes the number of
pixels to the left (negative number) or right
(positive number) to offset the shadow from the
image.

D Y Offset (pixels) establishes the number of
pixels up or down to offset the shadow from the
image.

E Shadow Blur controls the amount that the
shadow is blurred. A higher number indicates a
stronger blur.

F Opacity indicates the percentage that entire
shadow’s image is decreased.

G The Shadow Color pop-up palette includes an
assortment of colors. (These are the colors
you’ve already created in QuarkXPress.)

H The selected Auto Preview checkbox
immediately shows how the options you’ve
established effect the image. The Preview Now
button is only active when the Auto Preview
checkbox is not selected. When you click this
button, the Preview Area updates.

I The Save button gives you the option of saving
the current settings, while the Delete button
deletes them. Saved shadow sets appear in the
Shadow pop-up menu. Selecting a set displays
its settings in the dialog box. You can then
apply these shadow settings to the current
image.

J Zooms in and out. 

K The Apply button adds your created effect to
the image and closes the Bevel dialog box.

L The grow box resizes the dialog box and
preview.

The Shadow dialog box
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Tip

Holding down the Option key
with the mouse over the
preview will turn the Hand tool
into a pointer tool that allows
you to interactively adjust the
X/Y positioning.
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Troubleshooting

QX-Filters or QX-Effects

Why is my disk space sometimes lower after using QX-Filters or
QX-Effects?

When you run a filter on an image, QX-Filters and Effects create a
copy of that image in the same location as the original image (or in the
case of Effects, in the location you specify). If you are working with
large or complex images you can quickly create several copies of these
large filtered images which can begin to take up disk space. To avoid
wasted disk space, you should promptly delete unwanted images by
clicking Trash button in the QX-Filters dialog box or for Effects, going
to the Finder and dragging the unwanted images to the Trash. If you
are no longer in the QX-Filters dialog box, you can simply drag
unwanted image files to the desktop trash icon.

Why do I sometimes have trouble running Photoshop-compatible
filters within QX-Filters?

Since QX-Filters applies complex filters directly within QuarkXPress,
it may be necessary to increase the QuarkXPress memory partition by
at least one megabyte, especially if you want to use other Photoshop
compatible filters such as Kai’s Power Tools. The more memory
allocated to QuarkXPress, the faster the QX-Filters can acquire or filter
images.

How can I get the best results with QX-Effects?

You can try several things to make your effects look better when using
QX-Effects:

• If you are creating shadows and glows from images, use EPS images
with clipping paths as your “source.” QuarkXPress is able to work
with these types of images more successfully than TIFFs or PICTs. The
resulting shadows and glows will be TIFF files, as these produce more
pleasing results than would be possible with EPS files.

• Use “8-bit grayscale” when creating TIFFs whenever possible. They’ll
be smaller, print faster and will give you more control if you are trying
to place them on top of other images.

• If you create a bevel or emboss effect, you may wonder where the
“source” text box went. It was not deleted, rather, QX-Effects assigned
it to a hidden layer. To view this layer, use QX-Layers and look for the
“Hidden by QX-Effects” layer. Making this layer visible will show you
the source box for which you are looking.



57

Dealing with "Jaggy" TIFFs

Working with shadows, glows and other effects produced by QX-
Effects can be troublesome if you are trying to combine them with
other elements. This is not a defect in QX-Tools, rather it is a result of
trying to mix vector data (such as type or QuarkXPress elements) with
raster data (such as TIFF files which are created by QX-Effects) in a
PostScript environment.

Here are a few solutions:

• Above all, do not change the background color of the TIFF to
“None.” 

• Change the color of the TIFF to match the background object.
(Choose Modify from the Item menu or use the background color
button from QX-Bars). This works when the background object
surrounds the effect image and the effect image is grayscale (not
RGB or CMYK).

• If you need to place a QX-Effect on top of two differently colored
objects or on top of a photographic image, you’ll need to combine
the two images, or create a “burn.” Your best tool for this is a photo-
manipulation program, such as Adobe Photoshop.

This is a complex process and you will need to keep an eye on
details such as dpi and color balance. 

Using “1-bit Dithered” images instead of 8-bit grayscale images

As discussed, TIFF files don’t work well when placed on top of other
QuarkXPress elements. Creating a burn in Photoshop or another image
editing program is one solution, but doesn’t work if the TIFF is on top
of anything other than another TIFF file. For example, a TIFF file
cannot be “burned” into a colored QuarkXPress text box.

There is another solution that takes advantage of the way QuarkXPress
responds to one-bit images. Most TIFF images are “eight bits deep” or
better, which means that any pixel can be white, black or one of 255
shades of gray. Changing the background color of an 8-bit image to
“none” will cause QuarkXPress to create a jagged run-around.
However, it is also possible to create a TIFF file that contains pixels
that can only be white or black, or “one-bit deep.” Changing the
background color of a 1-bit image to “none” will cause QuarkXPress to
show the background through the image, which is what you probably
wanted in the first place.

QX-Effects provides an efficient way to generate drop shadows and
glows in 1-bit dithered format. This option appears in the QX-Effects
palette, under the "Image File Type" pop-up menu. Select this when
creating shadows and glows, and QX-Effects will produce images that
can be placed over other QuarkXPress elements.
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Tip

An updated list of technical
support questions and
answers can be found at:
http://www.extensis.com

For More Information

If you need more information, we’d suggest you pick up one of David
Blatner’s books about QuarkXPress. In these books you’ll find tips and
tricks that will get you through some situations. Another source is
Quark’s Technical Support, specifically the tech note titled “Jaggy
TIFFs” available either at the Quark web site or via the Quark Fax
Facts line. You’ll find some tips at the Extensis web site
(www.extensis.com).

QX-Layers

Although the QX-Layers locked column is checked, I can still move
layers which contain grouped objects.

Grouped objects cannot be locked with QX-Layers.

QX-Manager

Why does the following QX-Manager dialog box appear when
launching QuarkXPress?

Since QuarkXPress’ RAM allocation can be altered through 
QX-Manager or the Finder’s QuarkXPress Info window, a conflict can
occur if each of these locations is assigned a different memory
partition size. To resolve this conflict, QX-Manager displays the above
dialog box to determine which memory partition size you want to use.
Clicking the Cancel button starts QuarkXPress with the memory
partition size assigned in the Finder. To quit QuarkXPress and re-enter
a new memory partition size in the QX-Manger dialog box, click the
OK button. To avoid this conflict, simply use QX-Manager to make all
your memory partition size changes.



QX-Print

Why are EPS images sometimes slightly clipped when I use the
Save as EPS feature.

There is a bug in QuarkXPress which can cause a slight amount of
clipping (less than 1 pt.) on the top and right edges of a saved EPS file,
when saving selected item bounds to an EPS file. This occurs when the
origin of the selected item is on a non-integral offset (in points) from
the origin. For example, a horizontal offset of 23.5 pts. can exhibit the
clipping, whereas an offset of 23.0 pts. will not.

QX-Scaler

Why doesn’t QX-Scaler recognize when an object has been
previously scaled using the QuarkXPress scaling options.

When an object is selected to be scaled, QX-Scaler considers that object
100% or normal size. It does not recognize other previous scaling.

59


	Table of Contents
	More TOC
	QX-Tools 2.0 features.pdf
	QX-CopyStyle
	QX-Dingbats
	QX-DocStyles
	QX-Effects
	QX-Filters
	QX-FindChange
	QX-FineTune
	QX-Layers
	QX-Manager
	QX-Print
	QX-Scaler
	QX-SmartBar
	QX-Styles
	QX-Tips & Tricks
	QX-Viewer
	Extensis

	QX- Tools ......................................................................................
	Introduction..................................................................................................
	System and Software Requirements ............................................................
	Installation....................................................................................................
	Registration ..................................................................................................
	Technical Support ........................................................................................
	Suggestions ..................................................................................................
	QX- Tools Keyboard Shortcuts ....................................................................

	QX- Bars ........................................................................................
	SmartBars ....................................................................................................
	Displaying or Hiding Toolbars ....................................................................
	Resizing and Embedding Toolbars ..............................................................
	Creating and Editing Toolbars ....................................................................
	Adding and Deleting Buttons ......................................................................
	Moving and Adding Space Between Buttons..............................................
	Creating Your Own Buttons ........................................................................

	QX- Styles ....................................................................................
	Creating, Using and Editing Character Style Sheets ................................
	Creating and Editing Style Sets ................................................................
	Using the QX- Styles Toolbar ....................................................................

	QX- Layers ..................................................................................
	Creating, Deleting and Modifying Layers ................................................
	Creating Layer Sets....................................................................................
	Using Show/ Hide and Lock/ Unlock..........................................................
	QX- Layers Preferences..............................................................................

	QX- Scaler....................................................................................
	Scaling Items With QX- Scaler ..................................................................
	Using Interactive Scaling ..........................................................................
	Using the Individual Scaling Options........................................................

	QX- Tips & Tricks ........................................................................
	Reading QX- Tips ......................................................................................

	QX- Manager ..............................................................................
	Using QX- Manager....................................................................................

	QX- Viewer ..................................................................................
	Using QX- Viewer ......................................................................................

	QX- Filters ..................................................................................
	Using QX- Filters........................................................................................
	Filtering and Masking Images ..................................................................
	Extensis Filters ..........................................................................................
	QX- Filters Preferences ..............................................................................

	QX- Dingbats ..............................................................................
	Using QX- Dingbats ..................................................................................

	QX- Print......................................................................................
	Printing Discontinuous Pages ....................................................................
	Printing Multiple Plates ............................................................................
	Printing Spot Colors as Process Colors ....................................................
	Switching Between Dialog Boxes ............................................................
	Saving a Region as an EPS File ................................................................

	QX- FineTune ..............................................................................
	Paragraph ..................................................................................................
	Character ....................................................................................................
	Object ........................................................................................................
	Rule............................................................................................................

	QX- CopyStyle ............................................................................
	Using QX- CopyStyle ................................................................................

	QX- FindChange..........................................................................
	The Picture Boxes Panel............................................................................
	The Rules Panel ........................................................................................
	The Style Sheets Panel ..............................................................................
	The Colors Panel........................................................................................
	The Character Panel ..................................................................................
	The Paragraph Panel ..................................................................................
	The Lines Panel ........................................................................................
	The Frames Panel ......................................................................................

	QX- DocStyles ............................................................................
	Using QX- DocStyles ................................................................................

	QX- Effects ..................................................................................
	Using QX- Effects ......................................................................................
	Bevel ..........................................................................................................
	Emboss ......................................................................................................
	Glow ..........................................................................................................
	Shadow ......................................................................................................

	Troubleshooting..........................................................................

